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About this guide
This guide tells you how to protect your entire network from viruses by
using Sophos EM Library.

It tells you how to

� install EM Library

� set up automatic downloading of Sophos software

� install Sophos Anti-Virus (if you are a new customer) on Windows,
Mac, NetWare, Unix and Linux computers

� monitor downloading

� configure downloading

� uninstall EM Library.

More information
This guide describes the initial installation and use of EM Library.

� For information about using EM Library on large networks, and about
all configuration options, see the EM Library user manual.

� Most Sophos documentation is published on the Sophos CD each month.

Technical support
UK (24 hours): (+44) 1235 559933 support@sophos.com

USA (24 hours): (+1) 888 767 4679 supportus@sophos.com

Australia (24 hours): (+61) 2 9409 9111 support@sophos.com.au

France: (+33) 1 40 90 20 90 support@sophos.fr

Germany (24 hours): (+49) 6136 91193 support@sophos.de

Japan (24 hours): (+81) 45 227 1800 support@sophos.co.jp

Singapore (24 hours): (+65) 6776 7467 supportasia@sophos.com
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About EM Library

What is EM Library?

Sophos EM Library enables you to set up automatic updating of Sophos
software (applications, tools, virus identities) from a Sophos website.

Which types of computers can EM Library keep updated?

EM Library can maintain Sophos Anti-Virus on

� Windows NT/2000/XP/2003

� Windows 95/98/Me

� NetWare

� Mac OS X and OS8/9

� Unix and Linux.

How does EM Library work?

EM Library consists of

� a console used to administer the library (see below).

� a library to which you download software and from which you deploy it.

Once you have set up a library, it

� connects at set times to a databank, a Sophos website where the latest
versions of Sophos software are available

� downloads the latest versions of the software packages to which the
administrator has subscribed

� places the updated software in central installation directories (CIDs) in
a form suitable for installation on client computers.

The clients update automatically from the CIDs, provided the Sophos
software installed on them has been configured to do so.
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Upgrading to EM Library

How do I upgrade from Enterprise Manager 1.01/1.02 to EM Library?

If you installed Enterprise Manager on a single computer, install EM
Library 1.1 straight onto that computer. EM Library replaces the old
library and uses the settings you specified for it.

If you have “child” libraries, or manage more than one library from a
console, you should follow these guidelines:

� Start by updating the lowest-level “child” libraries and work upwards (as
your old libraries cannot update from new libraries created by EM Library).

� Libraries created with EM Library must be managed by consoles
created by EM Library. Likewise, libraries created by Enterprise
Manager must be managed by consoles created by Enterprise Manager.

For more information, see the EM Library release notes.

How do I use EM Library on networks where Sophos Anti-Virus has
already been installed manually?

EM Library can manage and update your existing installations.

If you have default central installations of Sophos Anti-Virus for Windows,
EM Library will find them and use them automatically (as long as they are
on the same computer).

If you have non-default central installations for Windows computers, or if
you want to keep NetWare, Mac or Unix computers updated, you have to
configure EM Library to take over your existing installations. The
instructions for setting up EM Library tell you how to do this.
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Using EM Library on large networks

How can I manage large networks more efficiently?

This guide describes the use of a single library. If you have a large network,
you can use additional central installations or libraries. See the EM Library
User manual, sections 15 to 22.

How can I use EM Library to help with software evaluation?

You may want to evaluate each version of Sophos Anti-Virus as it becomes
available and then decide whether to update your entire network. EM
Library enables you to do this by using “fixed version” software for your
main network and “latest version” software for the test network. See the
EM Library User manual, sections 23 to 25.
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1 Preparing for installation

1.1 About installation

To set up EM Library, you

� install the console

� create a library

� configure the library to download software automatically

� select the software you want to download

� select the directories to which the software will be downloaded (this step
is optional)

� pre-configure the software (this step is optional)

� download the software for the first time.

If you have not installed Sophos Anti-Virus on your network before, you
must then make a first-time installation. This guide leads you through that
process too.

1.2 System requirements

The computer where you install EM Library console needs to be running

� Windows NT 4 (Service Pack 6a), Windows 2000, Windows XP or
Windows 2003

� Microsoft Management Console (MMC) version 1.2 or higher

� Internet Explorer 5 or higher.

� 20 MB free disk space for installation. Additional space is needed for
the data held in libraries and central installations.

The computer on which the library is installed (the instructions in this guide
assume it is the same computer) must be running these services:

� Server

� Workstation

� Remote Procedure Call (RPC)

� Task Scheduler (only if you put the library on a different computer from
the console).
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You can check the status of these services via Control Panel|Services
(Windows NT), or Control Panel|Administrative Tools|Services (Windows
2000).  They must be configured to start automatically.  If the Task
Scheduler is not shown, a later version of Internet Explorer may need to be
installed (e.g. version 6)

If you use a dial-up connection to the internet, change your internet options
before installation, as described in the appendices of the EM Library user
manual.

If you access the internet via a proxy server, you should be using one of the
following authentication protocols: Anonymous, Basic or NT
Challenge/Response (NTLM).

1.3 The user accounts and groups you need

To use EM Library, you must have:

� An account that gives access to the Sophos web server.  The username
and password are supplied to you by Sophos.

� An account that EM Library uses. The setup program offers to create a
local account for you. However, if you want to use EM Library to
update CIDs on remote computers, you must specify a network
account.

You may also need the following accounts.

� Accounts or groups that are authorised to use the library.  Sophos
recommends that you create a new domain group for these users.

� The proxy server account (if you access the internet via a proxy).

If you have not installed Sophos Anti-Virus before, you will also need

� A network account used to update Sophos Anti-Virus automatically on
Windows NT/2000/XP workstations.  (See Appendix 1)
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1.4 Further steps if you already use Sophos Anti-Virus

If you already have Sophos Anti-Virus on your network, do as follows.

� Check and note down the location of your Sophos Anti-Virus central
installation directories (CIDs) or, in the case of Sophos Anti-Virus for
NetWare, the folder where updates are placed.

� Delete any virus identity files (IDEs) in your CIDs.

� If you have previously been updating Sophos Anti-Virus from CD, rather
than using Enterprise Manager, remove any previous installation of the
SAVAdmin administration tool (see details below). EM Library will install a
new copy of SAVAdmin.

To remove SAVAdmin, delete the SAVAdmin folder, located by default at

C:\Program Files\Sophos\SAVAdmin\Ver 2.20

You will not lose your SAVAdmin configuration information (for example,
SAVAdmin computer groups that you have set up).
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2 Installing EM Library

To install EM Library, you

� install the console (section 2.1)

� create a library (section 2.2).

If you are upgrading from Enterprise Manager, you do not see all the dialog
boxes shown below, and you do not have to reinstall or update your local
library.

2.1 Install the console

The console is an MMC snap-in that enables you to administer an EM
software library.

1. Log on as an Administrator at a Windows NT/2000/XP/2003 computer.

If you have already downloaded the EM Library files from the Sophos
website, unzip them, double-click Setup.exe and go to step 5.

2. Insert the Sophos CD in the CD drive. The CD should auto-run. If auto-run
is disabled, run D:\Launchcd (where D: is the CD drive).

3. In the Sophos CD window, click EM Library.

4. At the next screen, start the setup program. The installation wizard is
started.

5. In the Sophos EM Library Console - InstallShield Wizard dialog box, click
Next.
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6. In the License Agreement dialog box, read the agreement. If you accept the
agreement, click Yes to continue.

7. In the Setup Type dialog box, select Typical for a standard installation.
Click Next.

If you want to install the console in a non-default location, select Custom
instead. You will then see a custom setup dialog box in which you can
choose the location.
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8. In the Ready to Install the Program dialog box, click Next.

9. The progress of installation is displayed. Wait for installation to be
completed.
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10.In the InstallShield Wizard Completed message box, ensure that Launch
the program is selected. Then click Finish.

11.A progress bar is displayed. Wait for the console to be launched.
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12.The console is displayed as a snap-in within MMC 1.2.

The left-hand pane displays the console tree, which you use to access the
library (or libraries). The right-hand pane is the details pane. This pane
displays details of the item highlighted in the console tree.

You are now ready to create a library (section 2.2).

If you are upgrading from Enterprise Manager, you do not have to reinstall
your local library. However, if you now want to use EM Library to manage
Sophos Anti-Virus for Mac, NetWare, Unix or Linux, you should read
section 3 and then section 5 (or section 11, if you manage Unix or Linux).

MMC
menus

Console
tree

EM Library
menus

Details
pane
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2.2 Create a library

The library is a central location to which you download Sophos software.

1. In the console, in the details pane, click Create library.

2. In the Setup - EM Library (Welcome) dialog box, Local Installation is
selected by default. Click Next.

If you want to install a library on a remote computer, select Remote
Installation and follow the instructions. For details, see the EM Library
User manual, section 22.2.

3. In the Location dialog box, you specify where the library is installed. In the
Install Location text box, accept the default folder, or type an alternative
folder (as a local path). In the Library Share Name text box, accept the
default share name for that folder, or type an alternative. Click Next.
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4. In the Install Files dialog box, click Install to begin installing the library. A
progress bar is displayed.

You can not interrupt installation. If you click Cancel, the wizard is closed,
but installation continues.

5. When installation is complete, a SETUP message box is displayed.
Click OK. This starts a wizard that guides you through setting up an
account that EM Library can use (section 2.3).
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2.3 Selecting an EM Library account

Now you select the EM Library account.

1. In the Welcome to the Network Account Configuration Wizard dialog box,
click Next.

2. In the Select network account type dialog box, select the option that best
suits your needs.

If you have a single library and all the CIDs are on the same computer,
click Create a new local account. EM Library will create an account called
EMLibUser1. This is a member of “Administrators” and a new group called
“EM Library users”.

If you intend to have multiple libraries,or remote CIDs, click Select an
existing account. Enter the details of a domain account with domain
Admininstrator rights. (For details of how to create an account, see
Appendix 1.)

Click Next.
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3. In the Enter account password dialog box, enter and confirm a password.
Click Next.

4. In the Completing the Network Account Configuration Wizard dialog box,
click Finish.

Next you set up EM Library messaging so that you can receive error
messages or warnings when you configure the library (section 3).
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3 Setting up messaging

By default, EM Library places details of all its activity in the system Event
Log. You can also set up email or network messaging, so that you are
alerted to any problems.

1. In the console, on the Tools menu, select Options.

2. In the EM Library options dialog box, click the Notifications tab.

In the drop-down menu, select the form of message you want to receive
(e.g. email, desktop). Then deselect Disable alerts for this notification
method.

Select EM Library activity and then select all the options. This ensures you
receive information about any problems during installation.

Later, you can change these settings if you want to receive fewer messages.

If you are setting up email messaging, click Configure and continue to step
3. Otherwise go straight to section 4 to set up automatic downloading of
software.
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3. In the Email Settings dialog box, enter an email address in the “From”
address text box. Any undelivered email will be returned to this address. In
the Recipients  text box, enter an email address to which you want
messages sent and click Add. In the SMTP server text box, enter details of
your SMTP server. Then click Test. EM LIbrary will send a test message to
each recipient.

Click OK to return to the Notifications tabbed page. Then click OK again.

Now you set up automatic downloading of software (section 4).
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4 Setting up automatic downloading

Now you configure the library to download and update software automatically.

4.1 Select Parent

The parent is the location from which you download software.

1. In the console, in the details pane, the Configuration view is displayed.
Click Select Parent.
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2. In the Primary parent tabbed page, select the parent from which you will
download software. For this initial setup, ensure that Website is selected.
Select http://databank.sophos.com/databank. Click Set access.

3. In the Web server access settings dialog box, select Use an account to
access the server. Enter the User name and Password that Sophos has
given you for use with EM Library. Both are case sensitive.

If you do not access the internet through a proxy server, click OK and go
straight to step 5.

If you do access the internet through a proxy server, select Use a proxy
server and enter the server’s address and port number. If you need to enter
credentials to use the proxy, click Advanced and go to step 4. Otherwise, go
straight to step 5.

If you access the internet via a dial-up connection, make sure you have
changed your internet connection settings as described in the EM Library
User manual
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4. If you clicked Advanced, the Advanced Proxy server settings dialog box is
displayed. Ensure Authenticate on the Proxy server is selected. Enter the
User Name for the proxy server (available from your network
administrator). Enter and confirm the Password. Click OK to return to the
Web server access settings dialog box. Click OK to return to the Primary
parent tabbed page and then click OK again.

5. EM Library attempts to validate your account details. If it cannot (e.g.
because the details are incorrect, or because no network connection has
been made), it prompts you to make changes and try again.

When the account details are validated, the primary parent is displayed in
the Configuration view.

Next you schedule downloads from the parent (section 4.2).
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4.2 Schedule downloads

You must schedule downloads. EM Library will then download:

� New virus identities, which give protection against new viruses
automatically at the times you specify.

� Full product updates automatically at one of the times you specify. The
release of these updates is staggered, but you always receive the update
before it is available on the Sophos CD.

You can also carry out manual downloads (see section 16) or script automatic
updates from another program (see Appendix 3 in the EM Library user
manual).

1. In the Configuration view, click Schedule Downloads.

2. In the Update schedules tabbed page, click New schedule.
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3. In the Welcome to the Schedule Wizard dialog box, click Next.

4. In the Schedule Name and Description dialog box, enter a Name and
Description for the schedule. Click Next.
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5. In the next dialog box, you specify when the task will run. By default,
hourly updates are already set up. To change this, select the Days of week
when the task will run. Then, in the Hour browser, select an hour and click
Add. Repeat for each time when you want the scheduled task to run. To
remove a time, highlight the time in the right-hand window and click
Remove. Click Next.

The task will run during each hour that you selected (e.g. if you selected 9,
the task will run at a random time between 09:00 and 09:59).

6. In the Completing the Schedule Wizard dialog box, check that the details of
the schedule are correct. Click Finish.
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7. In the Update schedules tabbed page, the new schedule is now displayed in
the list. Ensure that the checkbox beside it is ticked so that the update will
be run at the set time(s). Click OK.

You can activate only one schedule (by ticking its checkbox) at a time.

You have configured EM Library to download updated software from the
parent at set times. Next select the software you want EM Library to
download and update (section 4.3).
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4.3 Select packages

Packages are Sophos products or files (e.g. Sophos Anti-Virus, virus
identities and administration tools) in a form suitable for downloading.

1. In the Configuration view, click Select/View Packages.

2. A progress bar is displayed.

If an error is reported, EM Library has either failed to read a file from the
databank or to write a file to the library or to a CID. It may be using an
account with insufficient rights, or your firewall may be blocking .DAT or
.DB files. Look in the message log (section 14) to find out what the
problem is.

3. In the Packages dialog box, the available software packages are displayed.
If no packages are displayed, check your connection to the Sophos databank.

By default, Sophos Anti-Virus for Windows packages are shown. To see
Sophos Anti-Virus packages for other platforms, deselect Show default
packages only.

To subscribe to packages, i.e. to ensure that they will be downloaded and
updated in future, select the check box(es) beside the packages. Click OK.

You have finished configuring the library to update software automatically.
Next download the software packages for the first time manually (section 5).
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5 Selecting directories for downloads

When EM Library downloads software, it places it in central installation
directories (CIDs) on the same computer as the library, from which it is
distributed across your network.

You should change the default directories if

� you already have CIDs in non-default locations

� you want to set up CIDs in non-default locations

� you want to use non-Windows versions of Sophos Anti-Virus.

If none of these apply to you, go straight to section 6.

5.1  Selecting the right directory for your operating system(s)

This section gives you advice on the type of directory you should use. The
next section tells you how to change a CID.

5.1.1 Windows

You do not need to change the Sophos Anti-Virus for Windows NT/2000/XP
and 95/98/Me CIDs unless you want to use a non-default directory.

5.1.2 Macintosh

You must place the Sophos Anti-Virus for Mac CID on a Windows 2000
server that has an AppleShare compatible network share, and you must set
read permission to "everyone" on that network share.

If you do not do this, EM Library cannot create the appropriate resource
and data forks on the CID. The files will be stored in archived “bin” format,
which the Macintosh workstations cannot use.

5.1.3 NetWare

You must ensure that EM Library places Sophos Anti-Virus for NetWare
updates directly into the updates folder on the NetWare server. By default,
this folder is SYS:/SWEEP/NLMINST. It is visible to the EM Library
computer as \\server\SWEEP\NLMINST. The NetWare servers will check for
updates placed here, every 5 minutes.

Sophos strongly recommends the use of Novell-supplied NetWare clients on
Windows computers, rather than the Microsoft NetWare clients.
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5.1.4 Unix

You must ensure that EM Library places the Sophos Anti-Virus for Unix
installation files in a Windows file store that can be read by Unix (e.g. a
Samba share). You must also run a script on your Unix client computers to
check for updates in that file store. A script is supplied by Sophos. See
section 11.
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5.2 Changing a central installation directory

To configure EM Library to use a non-default CID, do as follows.

EM Library cannot create shares on other computers. If you are going to
configure EM Library to use a CID on a remote computer, ensure a CID is
already present on that computer, or create a new share there first.

1. In the console tree, click Central Installations.

2. The default CIDs created by EM Library are displayed. Right-click on the
CID you want to change and select Properties.

3. In the Properties dialog box, click the Location tab. Select Custom CID
location and enter the full path of the shared folder. Click OK.
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4. If necessary, click the Credentials tab and enter the credentials EM Library
needs to access the CID, as described below. When you have finished, click
Test to check that the account can access the CID. Then continue to step 5.

To specify a Windows domain or local computer account

Enter

domain\account  or

computer\account

To specify a NetWare NDS account

Click NDS details. In the NDS Information dialog box, enter the tree name
and  fully distinguished names for the user and server in the format

cn=user.o=organisation

If you are uncertain what to enter, run the NetWare “NWADMIN” utility
supplied with the NetWare Windows client.

Then click OK to return to the Credentials page.
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5. In the details pane, check that the new CID location is displayed.

You have specified the CID(s) to which the software will be downloaded.

You can set certain configuration options for the software before you
download it. These options apply to Windows computers only and include
the frequency with which workstations will be updated.

If you want to pre-configure the software, continue to section 6.

If you do not want to pre-configure the software, you are ready to
download software for the first time. Go to section 7.



EM Library startup guide

37

6 Pre-configuring software

You can specify how, and how frequently, Windows workstations will
update themselves from the central directory (the default setting is
non-interactive updating every sixty minutes).

1. In the EM Library console, in the console tree, double-click EM Library.
Double-click Packages and then click Subscribed.

A subscribed package is one (selected by you during installation or
thereafter) that EM Library will download and update automatically.

2. In the list of subscribed packages shown in the details pane, highlight the
item you want and right-click. In the menu, select Create Customised
Copy.
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3. In the Package customisation wizard dialog box, click Next. The wizard
guides you through the steps you need to take (for details, see the EM
Library User manual). When you have finished, you must continue to step
4 to put the customised software in a central installation directory.

4. In the list of subscribed packages, check that the customised package is
displayed in the list. Right-click on the customised package. On the menu
that is displayed, click Add/Configure CID.

5. EM Library detects that the package is a customised copy of another
package that already has a central installation directory (CID). In the
message box, click Yes so that the customised copy can use the CID
instead.

6. Repeat steps 1 to 5 for each Windows package that you want to configure.

Next you download the software files for the first time (section 7).
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7 Downloading software

Now download Sophos software and place it in a central installation
directory or directories, as follows.

1. In the Configuration view, click Download Packages.

2. In the EM Library message box, click Yes.

3. The Updating packages from the parent progress bar is displayed.

4. When downloading is complete, the Updating your central installations
progress bar is displayed.

You have finished setting up EM Library.

If you have not already installed Sophos Anti-Virus on your network,
continue to the next part of this guide (sections 8 onwards).

If you have already installed Sophos Anti-Virus on Unix computers, you
must reinstall it to use the new auto-updating technology. See section 11.

If you have already installed Sophos Anti-Virus and have no Unix computers,
your entire network will be updated automatically from now on.
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8 Installing Sophos Anti-Virus on Windows

If you have not previously installed Sophos Anti-Virus from central
installations (CIDs) to your workstations and servers, you do so now. You
perform this procedure only once. Thereafter, Sophos Anti-Virus is updated
automatically. This section describes how to

� Install Sophos Anti-Virus on Windows NT/2000/XP/2003 computers
(section 8.1)

� Install Sophos Anti-Virus on Windows 95/98/Me computers (section 8.2).

Before you start, ensure you have a network account (with the right to log
on as a service) that the updating service can use. For details of how to
create a suitable account, see Appendix 1.

8.1 Install Sophos Anti-Virus on Windows NT/2000/XP/2003

You install Sophos Anti-Virus on Windows NT/2000 computers using the
SAVAdmin administration tool, which you can start from EM Library.

1. In the EM Library console, click on the library name to display the
Configuration view. Then click the Start SAVAdmin button.

Alternatively, on the Library menu, click Start SAVAdmin.

2. In the SAVAdmin console, in the tree in the left-hand pane, click Network
Neighborhood. Then click Entire Network. Under Microsoft Windows
Network, locate the domain or group where you are going to install
Sophos Anti-Virus. Highlight all the computers, or hold down the ‘Ctrl’ key
and select the computers on which you want to make an installation, and
right-click to display a menu. In the menu, select Install SAV.
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3. In the Task settings: Install SAV dialog box, the Common tabbed page is
open by default. Enter a Task name. Select Permanent to ensure that task
details are preserved even if SAVAdmin is restarted. Then click the CID list
tab.

4. In the CID list tabbed page, highlight SAV NT/2000. Click Change.
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5. In the Select CID dialog box, Registered is selected by default. A
“registered” CID is a shared directory which contains CIDs for multiple
products and is administered via the CID list in SAVAdmin.

In the drop-down menu, select the computer holding the central installation
directory (CID) for Sophos Anti-Virus for Windows NT/2000/XP/2003. By
default, this is the computer where the library is located. In the Full path
text box, check that the correct CID path is shown (if you accepted the
default settings when creating the library, the path is
[computername]\InterChk\NTInst\i386). Click OK. You are returned to the
CID list tabbed page.

6. In the Task settings: Install SAV dialog box, click the Account details tab.
Enter details of an account (with “Log on as a service” rights) that will be
used by the auto-update service. If you have not already created an
account, see Appendix 1 for details of how to do so. Click Create.
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7. In the SAVAdmin message box, click Yes to install Sophos Anti-Virus.

8. To check progress, at the SAVAdmin console, open the File menu and
select Task list. The install task you have created is displayed. In the Status
column, check that the task is Running or Completed. The results of the task
are displayed in a Task Summary window.

If the task is not completed successfully, click Edit to check the account
details and the CID selected, and then click Start to run the task again.

To close the task list, click Done.
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9. In the SAVAdmin console, check the SAV Installed, SAV Active and SAV
Version columns in the right-hand pane. You should see that Sophos
Anti-Virus has been installed. In the File menu, select Exit.

When EM Library updates the central installation directory, Windows
NT/2000/XP/2003 computers will update from it automatically within an
hour.

Sophos recommends that you set up a shortcut to the SAVAdmin program,
so that you can use it to monitor your Sophos Anti-Virus installations in
future. SAVAdmin is located in the EM Library folder, at

C:\Program Files\Sophos Enterprise Manager\console\bin\Savadmin.exe

For more information on using SAVAdmin, see the SAVAdmin user manual.

If you have Windows 95/98/Me computers on your network, install Sophos
Anti-Virus on them now (section 9.2).
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8.2 Install Sophos Anti-Virus on Windows 95/98/Me

You install Sophos Anti-Virus on Windows 95/98/Me computers by using a
login script (for instructions on creating a login script, see Appendix 2).

The same login script should be used to run the SAVAgent utility, which
enables you to use the SAVAdmin administration tool to monitor Sophos
Anti-Virus installations on Windows 95/98/Me computers.

Add the following lines to the computers’ login script:

\\<servername>\Interchk\W95Inst\setup -inl -a
start  /wait  \\[servername]\SophosEM\bin\Savagent.exe  -update  -poll=3600

where

� [servername] is the computer where you created the library

� Interchk is the share where the central installations were placed

� SophosEM is the location of the library.

This script installs Sophos Anti-Virus on each computer when it is restarted,
and configures it to check for Sophos Anti-Virus updates every sixty
minutes.
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9 Installing Sophos Anti-Virus on Mac

To install Sophos Anti-Virus on networked Mac computers for the first time,
do as follows.

At each workstation, ensure that

� the workstation is free of viruses (see the Mac on a network installation
guide for Mac OS X or Mac OS 8/9)

� System Preferences is closed (Mac OS X)

� the file server holding the CID is mounted on the desktop.

To install Sophos Anti-Virus:

1. Open the directory where EM Library placed the central installation. By
default, this is the macinst subfolder in the Sophos Anti-Virus folder on the
server.

2. Double-click the Sophos Anti-Virus Installer icon.

3. In the Sophos Anti-Virus Installer dialog box, click Install to install Sophos
Anti-Virus on the workstation at the default destination shown.

4. When prompted, enter your administrator account details (Mac OS X) or
restart the computer (Mac OS 8/9).

The computer now checks for updates automatically when it is turned on
(Mac OS 8/9), or when the Sophos Anti-Virus console is opened (Mac OS X).
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10 Installing Sophos Anti-Virus on NetWare

EM Library can keep Sophos Anti-Virus updated on NetWare servers, but
cannot be used for first-time installation. To install Sophos Anti-Virus on a
NetWare server for the first time, you must

� copy the Sophos Anti-Virus files from the Sophos CD or website (section
10.1)

� load Sophos Anti-Virus for NetWare for the first time (section 10.2)

� set up auto-updating (section 10.3).

10.1 Install Sophos Anti-Virus

You install Sophos Anti-Virus on the server from a Windows workstation.
We recommend that you ensure the workstation is virus-free before you
start.

1. At the workstation, log on to the server with write access rights equivalent
to ADMIN.

If you have already downloaded and unzipped the Sophos Anti-Virus for
NetWare files from the Sophos website, go to step 4.

2. Insert the Sophos CD in the CD drive. The CD should auto-run. If auto-run
is disabled, run D:\Launchcd (where D: is the CD drive).

3. In the Sophos CD window, click Sophos Anti-Virus. At the next screen, click
NetWare and then click How to install or update Sophos Anti-Virus. Scroll
down the page if necessary and click NETWARE.

4. Select all the files. Right-click the selection to display a menu. Select Copy.

5. In My Network Places (Windows Me/2000/XP) or Network Neighborhood
(Windows 95/98/NT), select the server and locate the SYS volume. Click
the SYSTEM directory. On the Edit menu, click Paste.

The Sophos Anti-Virus for NetWare files are copied to the directory.

You have installed Sophos Anti-Virus. Now load Sophos Anti-Virus for the
first time (section 10.2).
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10.2 Load Sophos Anti-Virus for the first time

1. At the server console, or using RCONSOLE from a workstation, type

LOAD SWEEP

2. The first time you load Sophos Anti-Virus, it prompts you to enter
Administrator details. Press any key.

3. At the login prompt, type an Administrator username and the name of your
Organization, and press Return. Sophos Anti-Virus will log in as this user
every time it is started, enabling it to see the complete NDS tree.

4. Type the Administrator password and press Return.

5. If a message about suborgunits is displayed, press Return.

The Sophos Anti-Virus screen is displayed.

 

You have loaded Sophos Anti-Virus.We recommend that you add the
command LOAD SWEEP to the AUTOEXEC.NCF file, so that Sophos
Anti-Virus will be restarted if the server is rebooted.

Next set up auto-updating (section 10.3).
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10.3 Set up auto-updating

You can configure the installation of Sophos Anti-Virus on the server so
that it will update automatically as soon as EM Library places an updated
version of the Sophos Anti-Virus for NetWare files on the server.

1. In the Sophos Anti-Virus screen, on the Main menu, scroll down, select
Administration and press Return to display the Administration menu.

2. On the Administration menu, scroll down, select Auto-updating and press
Return to display the Auto-updating screen.

3. Press Return. Set Status to Active and press Return. Press ‘Esc’ twice to
return to the Main menu.

From now on, Sophos Anti-Virus for NetWare will be updated automatically
by EM Library.
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11 Installing Sophos Anti-Virus on Unix or Linux

To install Sophos Anti-Virus on Unix or Linux computers for the first time,
or to reinstall it, do as follows.

1. Go to the root of the directory where EM Library has placed the Sophos
Anti-Virus files (the “CID”). Then copy the file eminstall.sh into an
executable path location such as /etc. on each Unix client.

From now on, this location is shown as <path>

2. Enter

cd <path>

3. To change the permissions, enter

chmod +x eminstall.sh

4. Create a file called /etc/eminstall.conf

5. Add the following lines to it:

EM install CID=<install_cid>
EM cache dir=<tmp_path>
SAV install dir=<install_path>

where

<install_cid> is the location of the CID.

<tmp_path> is the location of the cache where a copy of the installation
files is placed when performing an update.

<install_path> is the root location where Sophos Anti-Virus is going to be
installed, or has previously been installed.

The files in <tmp_path> must not be deleted as this will cause them to be
downloaded again. For this reason, you are recommended not to place the
files in the /tmp directory.

For the latest information about Unix/Linux installation and configuration,
see the eminstall.txt file in the central installation directory.

6. Run

eminstall.sh

Whether you are an existing user or a new user, you must now create a
cron job to run eminstall periodically. This will check for new virus updates
and product upgrades, and install them automatically.



Using EM Library
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12 Opening the console

You open the EM Library console as follows.

Sophos recommends that you keep the console closed unless using it.
Doing so saves bandwidth. You still receive alerts via email or network
messaging (see section 3).

1. In the Windows taskbar, select Start|Programs|Sophos Enterprise
Manager|Sophos EM Library Console.

2. The console is opened. In the Details pane, the last details you viewed are
displayed (if you saved your settings the last time you closed the console).

The sections that follow tell you how to

� check last and next download times (section 13)

� monitor EM Library activity via the message log (section 14)

� change the library settings (section 15)

� download updates manually (section 16).
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13 Checking last and next download details

In the EM Library console, you can check when EM Library last
downloaded updates, and when it will next do so.

1. In the console tree (left-hand pane), click EM Library.

2. In the Details (right-hand) pane, the Configuration view is displayed.

Last successful download details are displayed beside the Download
Packages button.

Next update time is displayed in the status bar (bottom left-hand side).
This is always displayed (unless you are using the Message log).
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14 Monitoring EM Library via the message log

To check whether a procedure has been carried out, look in the message
log.

1. In the EM Library console, in the console tree, click Message Log.

2. The messages are displayed in the details pane.

You can change the types of message (warning, error or information)
displayed, as described in section 3. Errors usually require you to take
action.

To export the messages to a text file, click the Export icon in the toolbar.

To see full details of any message, highlight it and right-click. In the menu
that is displayed, select Properties.

The messages are stored in the Application log in the system’s Event logs.
You can view them via the computer’s administration tools if you want to.
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15 Changing the library settings

You can change the options you set when you configured EM Library. You
can do this via the Configuration view or the Properties pages.

The Properties pages enable you to configure some extra settings, e.g. how
EM Library checks the integrity of files in the library.

15.1 Change settings via the Configuration view

1. In the console tree, click on EM Library.

2. In the details pane, the EM Library Configuration view is displayed. The
current settings are displayed. Click any button to edit them.

If you click Select Packages, a list of all available packages, including any
that you have customised, is displayed (rather than the initial package
selection dialog seen in section 4.3).

15.2 Change settings via the properties pages

1. In the console tree, right-click EM Library and select Properties.

2. A set of tabbed pages is displayed. Click a tab, e.g. Update schedules, to
edit that setting. For full details of all the options, see the EM Library User
manual.
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16 Downloading updates manually

EM Library automatically downloads the latest updates for subscribed
software packages from the parent at times you have already specified.

You can perform these downloads manually. See the instructions below.

You can also script downloads from other applications. See Appendix 1 in
the EM Library user manual.

1. In the console, on the Library menu, click Download Packages.

Alternatively, in the Configuration view, click Download Packages.

 

2. In the EM Library message box, click Yes.

3. The Updating packages from the parent progress bar is displayed. You can
close this message box without interrupting downloading, and can then
make changes on any other libraries managed from this console.

When downloading is complete, the last successful download date and time
shown in the Configuration view will change.



Uninstallation
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17 Uninstalling EM Library

To uninstall EM Library, you uninstall:

� the library (or libraries)

� the console(s).

Before you begin uninstallation, close the EM Library console and
SAVAdmin if necessary.

You cannot uninstall a library remotely. You must do so at the computer
where the library was installed.

1. Go to the computer where you installed the library. On the Start menu,
select Settings|Control Panel. Then double-click Add/Remove Programs.

2. Select Sophos EM Library and click Add/Remove.

3. In the Windows Installer message box, click Yes.

4. A progress bar is displayed.

5. Repeat steps 1 to 4 for the Sophos EM Console.
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Appendix 1: Creating a network account

To keep your network updated, you need

� An account used to update Sophos Anti-Virus automatically on
Windows NT/2000/XP/2003 computers. This account needs the right to
log on a service. If you have Sophos Anti-Virus on the network, you
may already have created this account.

� An account that EM Library uses. During library installation, the setup
program offers to create a local account for you. If you use EM Library
to manage CIDs on a remote computer, or if you use multiple libraries
that access each other via UNC, you need to use a network account
instead. This account needs the right to log on as a batch job.

This appendix describes how to create suitable network accounts on a
Windows 2000 computer.

The procedure is slightly different if you using another version of WIndows.
For instructions on how to create the account(s) on Windows NT or
Windows 2003, see the EM Library user manual.

1. In the Windows taskbar, select Start|Settings|Control Panel.

2. In the Control Panel window, double-click on Administrative Tools.
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3. In the Administrative Tools window, double-click Active Directory Users
and Computers.

4. In the Active Directory Users and Computers window, click on the Users
folder to open it. Right-click on the folder name. In the menu that is
displayed, select New and then User.
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5. In the New Object - User dialog box, in the Full name field, enter a
descriptive name (“EM Library” for the EM Library account or “Sweep
Update Account” for the Sophos Anti-Virus update account). In the User
logon name field, enter a name (“EM Lib” or “SAVUPD”). Click Next.

6. In the next dialog box, enter and confirm a password. Deselect User must
change password at next logon. Select User cannot change password and
Password never expires. Click Next.
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7. In the next dialog box, check the account details. Click Finish.

8. In the Active Directory Users and Computers window, the new account is
now displayed in the list of users.

If you are creating an EM Library network account, right-click the account
name and select Properties.

If you are creating an update account for Sophos Anti-Virus, close the window,
return to the Administrative Tools window and go straight to step 11.
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9. In the [Account name] Properties dialog box, in the Member of tabbed
page, click Add.

10.In the Select Groups dialog box, highlight Administrators. Click Add. Click
OK. Then in the [Account name] Properties dialog box, click OK.
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11.In the Administrative Tools window, double-click Local Security Policy.

12.At the Local Security Settings window, click the Local Policies folder and
then User Rights Assignment.

If you are creating an EM Library network account, highlight Log on as a
batch job.

If you are creating an update account for Sophos Anti-Virus, highlight Log
on as a service.

Then double-click.
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13.In the Local Security Policy Setting dialog box, click Add.

14.In the Select Users or Groups dialog box, select the new account.
Click Add.
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15.In the Local Security Policy Setting dialog box, the new account is now
displayed. Click OK. Close all windows.
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Appendix 2 Creating a login script

Sophos recommends that you install Sophos Anti-Virus on
Windows 95/98/Me computers automatically by using a login script. The
login script can also be used to distribute the agent that enables you to
monitor Windows 95/98/Me workstations with the Sophos administration
tool, SAVAdmin.

This appendix describes how to create a login script.

The procedure depends on whether you create the login script at a
Windows NT server or a Windows 2000 server.

Appendix 2.1 Creating a login script at a Windows NT server

1. At the file server, use Windows Explorer to find

C:\Winnt\system32\repl\import\scripts

2. In the File menu, select New and then Text Document.

3. Double-click the new document. The file opens in Notepad. Type

\\[servername]\Interchk\W95Inst\setup -inl -a
start  /wait  \\[servername]\SophosEM\bin\Savagent.exe  -update  -poll=3600

where

� [servername] is the name of your Windows NT server

� Interchk is the share for the Sophos Anti-Virus central installations
(CIDs)

� SophosEM is the share where you created the EM library.

In the File menu, select Save As.
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4. In the Save As dialog box, in File name, type login.bat. In the Save as type
browser, select All Files. Click Save. Exit from Notepad.

5. Close Explorer.

You now need to assign the login script.

1. In the Windows taskbar, select Start|Programs|Administrative Tools
(Common)|User Manager for Domains.

2. Select the users for whom the script is to be run.

3. From the User menu, choose Properties.

4. In the User Properties dialog box, click Profile.

5. In the User Environment Profile dialog box, in the Login Script Name field,
type login.bat. Click OK. Then click OK to exit the User Properties dialog
box. Exit User Manager for Domains.
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Appendix 2.2 Creating a login script at a Windows 2000 server

1. At the server, in the taskbar select Start|Programs|Accessories|Notepad.

2. In Notepad, type

\\[servername]\InterChk\W95Inst\setup.exe -inl -a
\\[servername]\SophosEM\bin\Savagent.exe -update -poll=3600

where

� [servername] is the Windows 2000 server

� Interchk is the share for the Sophos Anti-Virus central installations
(CIDs)

� SophosEM is the share where you created the EM library.

In the File menu, select Save.

3. In the Save As dialog box, browse for

C:\Winnt\SYSVOL\sysvol\[domain].com\scripts

where [domain] is your domain name.

In the File name field, enter login.bat. In the Save as type drop-down
menu, select All Files. Click Save. Close Notepad.

Next you assign the login script to the users who will have Sophos
Anti-Virus installed automatically.

1. In the Windows taskbar, click Start|Settings|Control Panel.

2. In the Control Panel window, double-click on Administrative Tools.

3. In the Administrative Tools window, double-click on Active Directory Users
and Computers.
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4. In the Active Directory Users and Computers window, double-click on the
Users folder. Select the users for whom Sophos Anti-Virus is to be installed
and right-click. In the menu that is displayed, select Properties.

5. In the Sophos User Properties dialog box, click the Profile tabbed page.
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6. In the Profile tabbed page, in the Logon script field, enter login.bat. Click
Apply and then OK.  Close all windows.

200401


	Contents
	About EM Library 
	Upgrading to EM Library 
	Using EM Library on large networks 
	Installing EM Library 
	1 Preparing for installation 
	2 Installing EM Library 
	3 Setting up messaging 
	4 Setting up automatic downloading 
	5 Selecting directories for downloads 
	6 Pre-configuring software 
	7 Downloading software 

	Installing Sophos Anti-Virus   
	8 Installing Sophos Anti-Virus on Windows 
	9 Installing Sophos Anti-Virus on Mac 
	10 Installing Sophos Anti-Virus on NetWare 
	11 Installing Sophos Anti-Virus on Unix or Linux 

	Using EM Library 
	12 Opening the console 
	13 Checking last and next download details 
	14 Monitoring EM Library via the message log 
	15 Changing the library settings 
	16 Downloading updates manually 

	Uninstallation 
	17 Uninstalling EM Library 

	Appendices 
	Appendix 1: Creating a network account 
	Appendix 2: Creating a login script 


